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[bookmark: _Toc67560475]
User Induction Checklist 

BEAMLINE INTRO

· Walkthrough
· Beamline staff – introduce, explain roles, how to contact
· LOGIN @ users account in diamond ws-001 computer
· Beamline user guide – red manual
· Food/drink rules – control room only, only hand-held stuff
· Restaurant/kitchens – opening hours
· Cantine 
Weekdays: Breakfast 7.30am – 9.30am. 
       Evening meal 5.30pm – 8.00pm (last orders at 7.45pm).
Weekends: Breakfast 8.00am – 9.00am. 		
       A packed lunch can be pre-ordered. Orders must be placed by 10 am.
· Chilton town (~2-3 miles) “The Rose & Crown”; Main St, Didcot OX11 0RZ
· Remove waste/samples at end of beamtime

SAFETY

· Fire escapes – locations and muster point
· Fire extinguishers – locations, only use if safe/trained
· Gas alarms - procedure
· EHCs – 8787
· Control Room – 8899
· Specific hazards – magnetic fields, high voltages,
· Lone working procedures – notify EHCs
· Motion stops

EXPERIMENTAL

· Vacuum schematic
· EPICS – interlocks, valves, shutter, PGM, mirrors
· GDA – perspectives, running/saving scripts
· Data retrieval/analysis  – FTP, DAWN, Igor
· Cryogens – PPE
· Gas bottles – EHCs to connect/replace
· Sample prep – no chemicals, nanomaterials
· Lab 51 – induction & lab form required


· Sign form on door

[bookmark: _Toc67560476]Sample Transfer

[bookmark: _Toc67560477]Introducing Samples into Load Lock

Having mounted your sample on the appropriate sample holder, test the electrical connections to ensure heater/thermocouple/drain current are correctly connected and follow the following procedure for introducing the sample into the load lock:

Close V51
Close V56
Switch OFF load lock IMG
Wait ~15 minutes for turbo to slow down
Open N2 bottle & set regulator to gentle flow
Open V57

Remove load lock lid when vented
Insert sample
Replace load lock lid

Close V57
Close N2 bottle/regulator
Open V56
Switch ON turbo 41
Switch ON load lock IMG

After approximately 30 minutes, the pressure should be good enough to transfer into the UFO chamber. (<1E-7 mbar)



[bookmark: _Toc67560478]Sample Manipulator Motion Axes 

The standard Diamond axis notation is used – positive is away from the synchrotron.

Xp – along the axis of the analyser (normal to the surface plane at rot = -25)
Zp – along the axis of the beamline
Yp – vertical

Important – always check the step size of the Xp motion (should be maximum 0.01 mm) – never type a number into the control box:

[image: ]Step size
Do not type in this box




[bookmark: _Toc67560479]Transferring Samples with TPOT chamber

Important - the transfer arm only rotates around the UFO in a clockwise direction: do not turn anti-clockwise unless you are moving sample into/out of a chamber otherwise the arm will jam.

[image: ../../../../../Downloads/IMG_3640.J]


@16/01/2020
Xp = 28.0
Yp= 246
Zp=23.15
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Sample Transfer Prep Chamber Sample in/out:
	
	Position 1
	Position 2

	Xp 
	25.02
	[image: C:\Users\scs05gh\OneDrive - Diamond Light Source Ltd\DIA_VERSOX\B07_C_Commissioning\B07_C_UFO_Prep\PreVac_Visit_1803\IMG_3634.JPG]
	27.39
28.0 @16/01/2020
	

	Yp 
	246 (wheel @ 2.5)
	[image: C:\Users\scs05gh\OneDrive - Diamond Light Source Ltd\DIA_VERSOX\B07_C_Commissioning\B07_C_UFO_Prep\PreVac_Visit_1803\IMG_3638.JPG] [image: C:\Users\scs05gh\OneDrive - Diamond Light Source Ltd\DIA_VERSOX\B07_C_Commissioning\B07_C_UFO_Prep\PreVac_Visit_1803\IMG_3639.JPG]
	245 (wheel @ 2.5)
	 

	Zp 
	23.15
	[image: C:\Users\scs05gh\OneDrive - Diamond Light Source Ltd\DIA_VERSOX\B07_C_Commissioning\B07_C_UFO_Prep\PreVac_Visit_1803\IMG_3636.JPG]
	25.33
	

	Rot 
	177.5° (see picture)
	[image: ]
	177.5° (see picture)
	[image: ]




[bookmark: _Toc67560480]Transfer UFO to Analysis Chamber

Close SHTRC (beamline experimental shutter)
Close gate vale 12
Open gate valve 23
Insert sample onto analysis manipulator
Open compressed air to lock sample into position – check that temperature reading is working
Remove transfer arm
Close gate valve 23
Open gate valve 12
Open SHTRC
Move manipulator to “safe” position
Move manipulator to “experiment” position



[bookmark: _Toc67560481]Transfer Analysis Chamber to UFO

Close SHTRC (beamline experimental shutter)
Close gate vale 12
Retract manipulator to move sample away from analyser cone
Move manipulator to “safe” position
Move manipulator to “transfer” position
Open gate valve 23
Close compressed air to release sample
Insert transfer arm
Remove sample and retract transfer arm
Close gate valve 23

[bookmark: _Toc67560482]Preparation Chamber

[bookmark: _Toc67560483]Sputtering


Close V58 to ion pump

Connect sample to ground via multimeter

Align sample in front of sputter gun (Xp = , Yp = , Zp = , Rot = )

Switch ON sputter gun power supply

Set ANODE potentiometer to 5.0 (50%)

Select Filament 1

Open leak valve to 8E-6 mbar Argon

Select filament current metering, and turn filament potentiometer to set current of 1.5 A

Select ANODE metering (discharge current)

Increase filament current until discharge strikes, then regulate at 30-40 mA

Increase ion energy to 1.5 keV




For more detailed instructions on the use of the sputter gun, see the appendix to this guide.

[bookmark: _Toc67560484]LEED Operation


For instructions on the use of the LEED, see the appendix to this guide.

[bookmark: _Toc67560485]Remote Operation - Access to Beamline Workstation

Diamond uses “NoMachine” to access the NX Linux cluster from which the beamline workstation can be accessed. Access is linked to a valid FedId and only possible during scheduled beamtime.

The IT User guide can be found here:

https://www.diamond.ac.uk/Users/Experiment-at-Diamond/IT-User-Guide.html
Click on ‘I am off site’:

https://www.diamond.ac.uk/Users/Experiment-at-Diamond/IT-User-Guide/Not-at-DLS/Nomachine.html

You will then be able to download NoMachine (if you don’t have it already) and follow the instructions for connecting remotely to the B07 workstation ws001



[bookmark: _Toc67560486]Beamline Operation

[bookmark: _Toc67560487]Start Beamline Synoptic

[image: ]  (top right) ->

  [image: ]   

-> Beamlines      ->BL07C VERSOX Near Atmospheric Pressure 

[image: ]

Beamline Synoptic will appear:

[image: ]

All beamline components can be accessed from this Synoptic. This is done by clicking on the light blue windows below each component.

The beamline is designed to be ‘user’ proof and as such is protected by interlocks.

If you are attempting to perform an action on some beamline components (e.g. valves and the SHTRC shutter) which is not being allowed it is always worth checking whether an interlock reset is required. This is shown in the image below.
[image: ]

[bookmark: _Ref46593676]Note: All open windows (including minimized windows) can be seen and accessed by clicking on the “Activities” button (top left of the screen

[bookmark: _Toc67560488]PGM: Changing Photon Energy

From Synoptic: PGMC

[image: ]

PGMC  Energy (bottom of window)  Override (bottom of new window)
· No override: slow movements – for NEXAFS
· Override : fast movements – XPS
· EXIT

Set the desired energy on the PGMC EPICS screen. 
Do this by entering the desired value in the PGMc Energy window (middle window of the right column in the figure above)
Check cff = 2

Do not change any other settings in PGMC Window



[bookmark: _Toc67560489]Recommended PGM Settings

PGM Grating:

PGMC -> Energy-> Grating Translation / Mirror Translation

The grating and mirror should be chosen according to the beamline transmission curve (see below) and required resolution (higher line density -> higher resolution). In general, the following combinations are recommended:

170 eV to 1000 eV:	400 l/mm		Pt mirror
1000 eV to 2000 eV:	600 l/mm (Pt)		Pt mirror
2000 eV to 2000 eV:	600 l/mm (Au or Pt)	Au mirror
			1200 l/mm		Pt mirror for high resolution (low flux!)

Exit Slit (S4C –> S4C y-gapsize):

[image: ]

Only change S4C y-gapsize
S4C x-gapsize should always be 0.5 mm

High resolution (low flux):	0.0125 to 0.0250 mm
Medium resolution:		0.0375 to 0.0625 mm
Low resolution (high flux):	> 0.0750 mm

Flux is roughly proportional to exit slit opening.
Resolution is roughly inverse proportional to exit slit opening.
The chart below shows the approximate beamline resolution for different photon energies, gratings and exit slits.





Approximate energy resolution (in eV) for different photon energies, gratings and exit slits. 
	
	400 l/mm
	600 l/mm
	1200 l/mm

	E_ph
	12.5
	25
	50
	100
	12.5
	25
	50
	100
	12.5
	25
	50
	100

	200
	0.029
	0.035
	0.052
	0.091
	0.024
	0.029
	0.042
	0.075
	0.017
	0.020
	0.030
	0.053

	300
	0.054
	0.064
	0.095
	0.168
	0.044
	0.053
	0.077
	0.137
	0.031
	0.037
	0.055
	0.097

	400
	0.083
	0.099
	0.146
	0.259
	0.068
	0.081
	0.119
	0.211
	0.048
	0.057
	0.084
	0.149

	500
	0.117
	0.138
	0.204
	0.362
	0.095
	0.113
	0.166
	0.295
	0.067
	0.080
	0.118
	0.209

	600
	0.153
	0.182
	0.268
	0.475
	0.125
	0.149
	0.219
	0.388
	0.088
	0.105
	0.155
	0.274

	700
	0.193
	0.229
	0.337
	0.599
	0.158
	0.187
	0.275
	0.489
	0.111
	0.132
	0.195
	0.346

	800
	0.236
	0.280
	0.412
	0.732
	0.193
	0.229
	0.337
	0.598
	0.136
	0.162
	0.238
	0.423

	900
	0.281
	0.334
	0.492
	0.873
	0.230
	0.273
	0.402
	0.713
	0.162
	0.193
	0.284
	0.504

	1000
	0.330
	0.392
	0.576
	1.023
	0.269
	0.320
	0.470
	0.835
	0.190
	0.226
	0.333
	0.591

	1100
	0.380
	0.452
	0.665
	1.180
	0.310
	0.369
	0.543
	0.964
	0.220
	0.261
	0.384
	0.681

	1200
	0.433
	0.515
	0.757
	1.345
	0.354
	0.420
	0.618
	1.098
	0.250
	0.297
	0.437
	0.776

	1300
	0.489
	0.580
	0.854
	1.516
	0.399
	0.474
	0.697
	1.238
	0.282
	0.335
	0.493
	0.875

	1400
	0.546
	0.649
	0.954
	1.694
	0.446
	0.530
	0.779
	1.383
	0.315
	0.374
	0.551
	0.978

	1500
	0.606
	0.719
	1.058
	1.879
	0.494
	0.587
	0.864
	1.534
	0.350
	0.415
	0.611
	1.085

	1600
	0.667
	0.792
	1.166
	2.070
	0.545
	0.647
	0.952
	1.690
	0.385
	0.457
	0.673
	1.195

	1700
	0.731
	0.868
	1.277
	2.267
	0.596
	0.709
	1.043
	1.851
	0.422
	0.501
	0.737
	1.309

	1800
	0.796
	0.945
	1.391
	2.470
	0.650
	0.772
	1.136
	2.017
	0.460
	0.546
	0.803
	1.426

	1900
	0.863
	1.025
	1.509
	2.679
	0.705
	0.837
	1.232
	2.187
	0.498
	0.592
	0.871
	1.547

	2000
	0.932
	1.107
	1.629
	2.893
	0.761
	0.904
	1.330
	2.362
	0.538
	0.639
	0.941
	1.670

	2100
	1.003
	1.191
	1.753
	3.113
	0.819
	0.973
	1.431
	2.542
	0.579
	0.688
	1.012
	1.797

	2200
	1.076
	1.278
	1.880
	3.338
	0.878
	1.043
	1.535
	2.725
	0.621
	0.738
	1.085
	1.927

	2300
	1.150
	1.366
	2.009
	3.568
	0.939
	1.115
	1.641
	2.913
	0.664
	0.788
	1.160
	2.060

	2400
	1.225
	1.456
	2.142
	3.803
	1.001
	1.189
	1.749
	3.105
	0.708
	0.840
	1.237
	2.196

	2500
	1.303
	1.548
	2.277
	4.043
	1.064
	1.264
	1.859
	3.301
	0.752
	0.893
	1.315
	2.334

	2600
	1.382
	1.641
	2.415
	4.288
	1.128
	1.340
	1.972
	3.501
	0.798
	0.948
	1.394
	2.476

	2700
	1.462
	1.737
	2.556
	4.538
	1.194
	1.418
	2.087
	3.705
	0.844
	1.003
	1.476
	2.620

	2800
	1.544
	1.834
	2.699
	4.792
	1.261
	1.498
	2.204
	3.913
	0.892
	1.059
	1.558
	2.767






D5c_cam2 diagnostic (camera on top of exit slits) can be used to check whether the beam is centred at the exit slit. It should appear as a “flame” on the cross (cross at x:540, y:840) as shown below:

[image: ]

You can try changing the exposure time of D5c_cam2 to get a better image.


[bookmark: _Toc67560490]Beamline Transmission Curves

[image: ]





[bookmark: _Toc67560491]XPS / NEXAFS Measurements

[bookmark: _Toc67560492][image: ]Start GDA

[image: ] -> Start GDA Server (only at the beginning of beamtime or if reset is necessary)

[image: ] -> Start b07-1 GDA Servers 

Will ask for confirmation, click on “Yes”
GDA Log Panel will appear
Wait until following message appears in GDA Log Panel:
“INFO  uk.ac.diamond.daq.server.GDAServerApplication - main object server started”

[image: ] -> Start b07-1 GDA Client

The GDA Data acquisition window will appear (this will take a few seconds):

[image: ]

The GDA Window should have four perspectives (their symbols are visible at the top right; note, the above example shows only three perspectives):

· GDA Scripts – allows to write and send scripts
· SPECS Perspective – allows to acquire data with the electron analyser. These can be visualised either as a single iteration (Iteration Spectrum tab) or as the sum of multiple iterations (Spectrum tab). It also provides a standard Jython consol to send other commands/measurements (Jython Console tab). These data can be visualised as they are being collected (Scan Plot 1 tab).
· Alignment Perspective – allows to choose the best sample-analyser working distance and the beamline’s refocussing mirrors’ optimum incident angles by maximising counts in the analyser whilst tweaking xp, m4c_pitch and m5c_pitch.
· Data Vis – allows basic data visualisation and comparison.

If a perspective is missing:
Window -> Open Perspective -> Other -> pick the required perspective.

[bookmark: _Toc67560493]Sample Alignment

[bookmark: _Toc67560494]Preparation:

· Check sample manipulator is at “Experiment” position
· Check that Sample is grounded either through FEMTO or via BNC shorting cap. Depending on the sample holder and the experiment the grounding can be either through the drain current connections or through the thermocouple.
· Check that valves 22, 25, 12 and ESHTR (entry shutter) are OPEN.
· Reset NAPES vacuum interlocks before opening valve 12
· Check that ea_shutter (ESHTR fast shutter in beamline entrance) is OPEN
· Open SHTRC experimental shutter
· Check that D22C Camera (NAP-ES –>Cameras) is working and that laser spot is visible on sample 
Important: if you cannot see the laser DO NOT MOVE THE SAMPLE.


[bookmark: _Toc67560495]Initial Alignment via GDA

· Open Alignment perspective
· Go to “Alignment” window
· Choose settings. i.e. KE 700 @ 1200eV; EP 40; Values: 1000; Dwell: 1
· Press “Set”, then “Start”
· Open window  Show View  Alignment Spectrum to see the graph
· Move Xp stepwise, (0.01 mm steps) monitoring D98c or D22c camera and maximise counts in analyser
· Note the maximum of counts is reached when the sample is ~ 0.25 mm away from the analyser cone
Important: if you cannot see the laser dot then the sample may be in contact with the analyser cone – STOP approaching immediately.
· Tweak  M4c_pitch and M5c_pitch to maximise counts
· Press “Stop”

[bookmark: _Toc67560496]XPS Measurements

[bookmark: _Toc67560497]Pre-Measurement Checks

Login to SPECS PC:
[image: ] -> 
  -> SPECS Analyser PC
[image: ]

The SPECS Prodigy Control Window will appear.

Click on the “Remote Control” Tab of the right panel:

[image: ]

· Make sure Experiment shows “B07_XPS_Template” (This sets the auto compact to compress both energy and scans)
· If not: unclick “Allow Remote connection”  change  click “Allow Remote connection”
· Ensure “Allow remote connections” is ticked in SPECS Prodigy
· Check that the Detector parameters agree with the image shown above.

Endstation:
· Check that Sample is grounded either through FEMTO or via BNC shorting cap. Depending on the sample holder and the experiment the grounding can be either through the drain current connections or through the thermocouple.
· In some cases, charging has been observed when thermocouple is connected.

EPICS:
· PGM energy: OVERRIDE

[bookmark: _Toc67560498]XPS Measurement using GDA:

· Create a new sequence using the [image: ] button at the top right of the SPECS perspective in GDA . Alternatively load an existing sequence using the [image: ] button. 
· A sequence consists of one or several regions, each represented by a line in the sequence editor.
· The “Sequence editor” (top panel) allows adding, duplicating and deleting regions using the [image: ] buttons.
· A sequence is saved using either of the [image: ]  buttons, but only when no spectrum is recorded. Sequences should be saved to the directory
/dls/b07-1/data/<year>/<proposal-No>/xml/
· Regions can be edited in the “Region Editor” (bottom left) after highlighting them in the Sequence Editor.
Typical Parameters:
· Acquisition Mode:
Fixed Transmission for XPS
Snapshot for NEXAFS (see below) 
· Lens Mode: SmallArea
· PSU Mode: 1.5kV for kinetic energies < 1.5 eV; 3.5kV if above
· Energy Mode: Binding for XPS; Kinetic AES
· Start / End: as required
· Step: recommended < 0.1 eV (except for survey spectrum)
· Pass energy: 
2/5 eV for high resolution;
10/20 eV for medium resolution;
40 eV for low resolution (high signal).
The energy resolution of the analyser is approximately 1 % of the pass energy (e.g. 100 meV for PE 10 V). As a rule of thumb, the analyser resolution should be kept below half the energy width of the beamline (this way the contribution of the analyser to the overall experimental broadening is less than 12 %).
· Exposure Time: typically 0.2 – 1 s
· Iterations: as required (can be reduced during scan)
· Slices 100 (always)

 
· To start a spectrum, the regions to be used must be ticked in the Sequence Editor.
· A measurement, using the regions as defined in the sequence, is started by using the [image: ]  button. Alternatively, the sequence can first be saved by [image: ] and then the analyser can be started by [image: ]
· While a spectrum is recorded, it can be seen in the Spectrum Tab at the bottom right.
· The spectra will be saved in NEXUS (HDF-5) format to the directory 
/dls/b07-1/data/<year>/<proposal No>/
under the file name
b07-1-<number>.nxs


[bookmark: _Toc67560499]XPS script:

Set up a sequence name_of_sequence.seq with desired regions etc and save using [image: ]

Sequence name
Beamtime
directory


analyser.setSequenceFile('/dls/b07-1/data/2018/si1234-1/xml/name_of_sequence.seq')

scan dummy a 0 0 1 analyser ring_current


Script should be saved to the directory
/dls_sw/b07-1/scripts/<proposal No>


[bookmark: _Toc67560500]NEXAFS Measurements

[bookmark: _Toc67560501]Pre-scan Checks:

· PGM energy: NO OVERRIDE
· In SPECS PC / Prodigy:
· Make sure Experiment shows “B07_NEX_Template” (This sets the auto compact to compress both energy and scans)
· If not: unclick “Allow Remote connection”  change  click “Allow Remote connection”
· Ensure “Allow remote connections” is ticked in SPECS Prodigy

· Thermocouple is disconnected (not necessarily)
· Heater is disconnected (not necessarily)
· Sample is grounded (either through a current amplifier or through a grounding cap)
· Analyser cone drain current is connected to SR570 – 2 ( femto_22 in the GDA command line)
· Beamline Entrance nozzle is connected to SR570 – 1 (femto_21 in the GDA command line)
· Check SR570-1 and SR570-2 are in the right range 
(access via Synoptic -> NAP-ES -> User Equipment -> SR Amp 1/2/3) 
· D21c is in the “Mesh” position (GDA command: pos d21c_positioner ‘Mesh’). This is connected to FEMTO 23 (tbc)



[bookmark: _Toc67560502]NEXAFS Scripts

Example TEY script:

Acquisition time (sec)
End energy


scan pgm_energy 500 530 0.5 ca23c 1 ca22c 1 ring_current
Acquisition time (sec)
Energy
step
Start
energy




Example AEY script:

(set up and save name_of_sequence.seq with desired settings for snapshot mode before sending)

Snapshot name
Beamtime
directory


analyser.setSequenceFile('/dls/b07-1/data/2018/si1234-1/xml/name_of_sequence.seq')

scan pgm_energy 280 305 0.05 analyser ca23c 1 ca22c 1 ring_current



PGM energy NO override



[bookmark: _Toc67560503]Gas Handling

[bookmark: _Toc67560504]Operation of Valves and Gauges

Most valves and gauges described below can be operated either via EPICS or the PLC.


[bookmark: _Toc67560505]EPICS
NAP-ES -> Vacuum

[image: ]



The X-ray beam enters the end-station from right to left in the above picture. 

Before entering the end-station the beam passes through the differentially pumped Beamline Entrance (BLE), shown as a rocket in the image above. 

The analyser is also differentially pumped and for simplicity is shown above at a 90 degree angle with respect to the BLE. In reality, the analyser is mounted at approximately the magic angle with respect to the incident beam.

Endstation components such as valves, gauges and pumps can be controlled via this screen by clicking on the component of interest.

Example of some EPICS pictograms are shown below:


[image: ] = scroll pump

[image: ] = turbo pump

[image: ] = gate valve

[image: ] = IMG and Pirani gauges

[image: ] = RGA and Capacitance gauges


As a general rule green indicates that a component is on/open whereas red indicates it is closed/off.

It is worth remembering to try a reset on any given component if an action is not being allowed.





[bookmark: _Toc67560506]PLC

The pumpdown sequence and valve 50 are only accessible via the PLC / HMI screen. This can be accessed through Tiger VNC Viewer:Activities- >   
[image: ]







[image: ]



Connect to 10.76.8.22   
Password: 888888
[image: ]


As with the EPICS synoptic single components can be accessed and controlled by clicking on the respective pictograms in the PLC shown above.

The image above shows the experimental chamber section.

By clicking on Beam Entrance and Analyser the relevant sections appear. 

To exit any section simply click on the red cross in the top right corner.

It is worth remembering to try a reset on any given component if an action is not being allowed.
















[bookmark: _Toc67560507]Introducing Gases (Manual Control)


Open leak valve until pressure starts to rise on HCG-25
Turn OFF emission on HCG-25
Close V24 (isolates turbo)
Continue Opening leak valve slowly until desired pressure on CAP-03/CAP-04


Alternatively use Piezo Leak Valve
BL-Synoptic -> NAP-ES -> User Equipment -> PLV1000
· Type voltage in the upper field, followed by ENTER
· Press ON and the voltage should appear in the lower panel
· Once ON has been pressed, the voltage can be updated (type number and ENTER)
· OFF will ramp down to voltage slowly to zero.
The valve will start to open at 400 – 500 V. 
The maximum voltage is 1000 V, which corresponds to ~ 10- 20 mbar (depending on gas) when V24 and V37 are both closed.  

[bookmark: _Toc67560508]Introducing Gases (Gas Rig)

USE ONLY IF INSTRUCTED BY BEAMLINE STAFF

In progress

[bookmark: _Toc67560509]Pump Out

To be updated




[bookmark: _Toc67560510]Pumping Out (Manual Control)

To be updated



[bookmark: _Toc67560511]Temperature Control: Eurotherm Operation

RETRACT SAMPLE BEFORE HEATING!

The Eurotherm can be used either manually, through its EPICS control window, or via GDA.


[bookmark: _Toc67560512]Pre-heating Checks:

· Ensure that the heater cable is connected at the manipulator
· Ensure that the thermocouple (green cable) is connected at the manipulator and a sensible temperature is being read by the Eurotherm
· Ensure the power supply (above Eurotherm) is switched ON 
· Ensure the sample has been retracted away from the analyser cone
· Compressed air to be flowed through the manipulator 


[bookmark: _Toc67560513]Heater EPICS Operation (located at NAPES  Motion  Sample heater):

· Type desired heating rate and temperature set point
· When at stable temperature, re-approach analyser cone with fixed energy scan
· For more rapid cooling after heating experiment, ask for compressed air to be flowed through the manipulator – see beamline staff

[bookmark: _Toc67560514]GDA Scripts for Temperature control:

[bookmark: _Toc67560515]GDA script that records XPS at 10° increments from 100-400 °C:

analyser.setSequenceFile (/dls/b07-1/data/<year>/<proposal No>/xml/name_of_sequence.seq)
scan sample_temperature 100 400 10 analyser


[bookmark: _Toc67560516]Other Commands:

To know the current ramp → sample_temperature.getRampRate()
To select/change a 5 °C/min ramp → sample_temperature.setRampRate(5) 
To set the new set point → pos sample_temperature XXX
To stop the ramp before raise the final temperature → sample_temperature.stop()
To set the accuracy level → sample_temperature.setAccuracy(1.0) 
To get the current accuracy level → sample_temperature.getAccuracy()


[bookmark: _Toc67560517]Cooling with Liquid Nitrogen


If desired, temperatures down to 150 K can be achieved by flowing liquid nitrogen through the manipulator as follows.


Check that the setup is connected as shown in the cartoon below (ensure that there is sufficient insulation around all pipes):

[image: ]

[bookmark: _Toc67560518]Cooling Procedure:

Flow N2 through for ~10 mins to purge any oxygen from the lines

Fill dewar with liquid N2 (wearing appropriate PPE)

Adjust N2 flow as required to keep desired temperature



[bookmark: _Toc67560519]Warming up Procedure:

Remove Dewar

Continue blowing N2 through until all liquid is consumed in the heat exchanger

Close off N2 flow and disconnect (pipes will be very cold!!!)

[bookmark: _Toc67560520]Trouble Shooting

[bookmark: _Toc67560521]Troubleshooting – GDA acquisition problems


If the scan fails to run – first check that the analyser EPICS interface is still connected: Go to the synoptic and select NAP-ES:SPECS Analyser and check that the CCD is connected (if not, just click reconnect)

[image: ]Connection status





The connection between GDA and the analyser occasionally drops out, which results in slow/faulty updating of the spectra within the GDA window. To recover, in the first instance try the following:

Dump current plot data (save to nexus file)
Close the GDA client
Restart GDA server (Diamond Launcher  Start B07-1 GDA Servers)
Wait until this process finishes (generally a couple of minutes)
Restart GDA client (Diamond Launcher  Start B07-1 GDA Client)

In case this doesn’t resolve the problem, a reset of the IOC may be required, as detailed below:

Close the GDA client
Go to “Hardware Status” on synoptic screen (lower left)
Click Start/Stop tab for NAPES (Analyser) BL07C_EA_IOC_02
Restart this IOC
Restart GDA server (Diamond Launcher  Start B07-1 GDA Servers)
Restart GDA client (Diamond Launcher  Start B07-1 GDA Client)
Reconnect analyser in EPICS window



[bookmark: _Toc67560522]Troubleshooting – PGM Motion Failure

An amplifier loss on the Geobrick that controls the PGM can be recovered as follows:

1) By pressing STOP on the energy window of the PGM screen and inputting the desired value again.

2) Hardware status  Geobrick PGMc  Terminal  Connect  type: ena plc6  Send  Disconnect






[bookmark: _Toc67560523]Troubleshooting – Magnetic Field


· Disconnect the device in Specs prodigy
· Switch off the three power supplies of the coils
· Unplug and re-plug the Armin plug into the socket. It is in the rear part of the analysis rack   3, bottom right, and labelled.
· Switch on the three power supplies 
· Connect the device in Specs prodigy
· Check if the enable LED is on in the three power supplies 


[bookmark: _Toc67560524]Useful GDA Commands

	GDA Command 
(italics = stuff you can change)
	What it does

	analyser.getWorkFunction()
	Gets current value of workfunction

	analyser.setWorkFunction(5)
	Sets value of workfunction

	femto_name.setSettleTime(500)
	Sets settle time of femto_name

	femto_name.setAutoGain(True/False)
	Sets autogain on/off for femto_name

	femto_name.isAutoGain()
	Gives autogain setting for femto_name

	pos expt_shutter 'Close'
	Closes experimental shutter (replace Close-Open)

	pos pgm_energy 743.3
	Sets photon energy to 743.3 eV




	

Femto Names
	sample_current
	Sample drain current 

	femto_22
	Analyser cone  (Stanford 2)

	femto_21
	BLE nozzle  (Stanford 1)

	Femto_?
	Diognostic 21 mesh (?)

	femto_xx
	Gas cell

	femto_xx
	Gas cell photodiode





[bookmark: _Toc67560525]Scripts

[bookmark: _Toc67560526]Acquiring XPS spectrum via script
analyser.setSequenceFile('/dls/b07-1/data/2018/siXXXX-1/xml/name_of_sequence.seq')
scan dummy a 0 0 1 analyser

[bookmark: _Toc67560527]Acquiring NEXAFS spectrum via script
pos ea_shutter ‘Close’

pos pgm_energy 280
pos d21c_positioner ‘Mesh’

pos ea_shutter ‘Open

analyser.setSequenceFile('/dls/b07-1/data/2018/siXXXX-1/xml/name_of_sequence.seq')
scan pgm_energy 280 305 0.05 analyser sample_current 5 ca21c 5

pos ea_shutter ‘Close’

pos d21c_positioner ‘Out of Beam’

The above scans the photon energy from 280 eV to 305 eV, in 0.05 eV steps, acquiring AES NEXAFS via the analyser (assuming snapshot mode), TEY from the drain current, and an I0 from the mesh on d21c.

[bookmark: _Toc67560528]Changing Grating via GDA 

Not working smoothly yet

#400l/mm grating, mirror: Pt stripe
pos pgm_grating '400 lines/mm'
pos pgm_mirror 'Pt Stripe'

#400l/mm grating, mirror: Rh stripe
pos pgm_grating '400 lines/mm'
pos pgm_mirror 'Rh Stripe'

# 600l/mm grating: Rh stripe, mirror: Rh stripe
pos pgm_grating '600 lines/mm'
pos pgm_grating_x -91.7
pos pgm_grating_x -91.9
pos pgm_mirror 'Rh Stripe'

# 600l/mm grating: Rh stripe, mirror: Pt stripe
pos pgm_grating '600 lines/mm'
pos pgm_grating_x -91.7
pos pgm_grating_x -91.9
pos pgm_mirror 'Pt Stripe'

# 600l/mm grating: Pt stripe, mirror: Pt stripe

pos pgm_grating '600 lines/mm'
pos pgm_grating_x -107.1
pos pgm_grating_x -106.9
pos pgm_mirror 'Pt Stripe'

# 600l/mm grating: Pt stripe, mirror: Rh stripe
pos pgm_grating '600 lines/mm'
pos pgm_grating_x -107.1
pos pgm_grating_x -106.9
pos pgm_mirror 'Rh Stripe'


Add something about Georg’s script

[bookmark: _Toc67560529]Data Treatment

[bookmark: _Toc67560530]Data Visualization/Extraction 

GDA: 		Script perspective
Specs perspective
		DataVis  

DAWN:  (module load dawn\2.5   dawn  @ October 2017)
Trace or DataVis perspective to visualize and compare:
File  new project  Data  Data project (linked…)  select the external folder



[bookmark: _Toc67560531]Data extraction:

Windows PC  explorer: \\data\b07-1\data

FTP:	Load your data from your explorer at: \\diamftpserv01\ftpanon\B07  
Take the data from:  ftp://ftpanon.diamond.ac.uk/B07/

Dawn:  Convert .nxs to XY
  		Processing Perspective
        		Select a file		dataset: spectrum
                            			line [1d]
                            			select KE, BE..
        		Processing window		export to text file
        		Run from data slice view window

[bookmark: _Toc67560532]Conversion to *.txt
 Within the processing folder of your own experiment folder (typically dls/b07-1/data/2019/sixxxxx/) create a new folder named convert in processing and copy the data files to that folder. 
 Then from a terminal input the command: 
 /dls_sw/b07-1/scripts/B07_SCRIPTS/b07_convert_nxs_to_txt_new.py /dls/b07-1/data/2019/sixxxx/processing/convert 
· Data extracted: kinetic_energy vs intensity 
 /dls_sw/b07-1/scripts/B07_SCRIPTS/b07_convert_nxs_to_txt_new2.py /dls/b07-1/data/2019/sixxxx/processing/convert 
· Data extracted: binding_energy vs intensity 
 This will makes .nxs files in the ‘convert’ folder to .txt files 



[bookmark: _Toc67560533]Data analysis

Users can analyse their data in the beamline hutch windows computer with Igor pro software.
Copy/access your data.
· Make a local folder to copy your data.
A) If you are logged in with your credential (diamond login id and password),
Then type \\data.diamond.ac.uk  in the address bar to access your data from
[image: ]
B07-1>data>2019>your data directory (for example si2218184-1)

B) If you are logged in as b071user then you have to access your data from the same directory through ftp via Filezilla ftp client software
Your data folder path: dls/b07-1/data/2019/SIxxxx
[image: ]Host: ssh.diamond.ac.uk
Put your diamond username

[image: ]


[bookmark: _Toc67560534]Normalization


TOP-UP normalization: 
· ring_current
· S2c as detector GDA Command (s2c_ytop_current)



[bookmark: _Toc67560535]Igor procedure files

We have two procedure macros for igor, which enables us to easily convert nexus files into igor waves and analyse xps data.
· In Igor pro macros HDF Files allow you to convert nexus data files to igor binary waves

[image: ]
· XPS macro allows you to perform some analysis like normalization, background subtraction, fermi energy correction etc.

1. If you are logged in as b071user 
The macros are already loaded.

2. If you are logged in as yourself (your user name)
First check if you have hdf browser installed in igor.
[image: ]
If yes, then load the macros directly from.\\diamftpserv01\ftpanon
B07-->Igor macros

If you do not see hdf browser installed. First install the hdf browser and then load macros.



[bookmark: _Toc67560536]Useful Beamline Information and Spectra
[bookmark: _Toc67560537]Beamsize at the sample on B07C

Measurement Procedure: 

PGM: 600 l/mm; Pt mirror
Photon energy: 1200 eV

Sample: thin rectangular mica sheet (<<0.1 mm x 11 mm x 7 mm) on bare sample holder; edges aligned with yp/zp directions of sample manipulator. The sample holder is at normal incidence.

	y gap size / mm
	vertical beam size 12% - 88% / mm

	0.200
	0.103

	0.150
	0.090

	0.100
	0.075

	0.075
	0.070

	0.050
	0.066

	0.025
	0.062 / 0.065



	z gap size / mm
	vertical beam size 12% - 88% / mm

	0.173
	0.090

	0.185
	0.090




[image: ]
[image: ]


[bookmark: _Toc67560538]Au4f spectra under H2 and N2


h = 500 eV  S4c = 0.8 x 0.05
[image: ][image: ]


h = 500 eV  S4c = 0.8 x 0.05
[image: ][image: ]


h = 500 eV  S4c = 0.8 x 0.025
[image: ][image: ]
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[bookmark: _Toc46603088][bookmark: _Toc46603089][bookmark: _Toc46603090][bookmark: _Toc46603091][bookmark: _Toc46603092][bookmark: _Toc46603093]

[bookmark: _Toc67560539]Installing the HDF5 package for Igor

Installing HDF5 requires activating two files – the HDF5 XOP file and the “HDF5 Browser” procedure file – by placing aliases (Mac OS X) or shortcuts (Windows) for them in special folders.
A. From the Help menu, choose “show Igor Pro User Files”. This displays the Igor Pro User Files folder on the desktop. These instructions assume that you are using the 64-bit version of Igor.
From the Help menu, choose “Show Igor Pro Folder”. This displays the Igor Pro Folder on the desktop.
Make an alias (Mac OS x) or shortcut (Windows) for the following file: Igor Pro Folder\More Extensions (64-bit)\File Loaders\HDF5-64.xop
	Move the alias or shortcut into “Igor Pro User Files\Igor Extensions (64-bit)”. This activates the HDF5 XOP, which adds operations to Igor for interaction with HDF5 files. 
The HDF5-64.xop file contains within it the necessary HDF5 libraries so you do not need to install libraries from the HDF Group.
B. Make an alias (Mac OS X) or shortcut (Windows) for the following file:
Igor Pro Folder\WaceMetrics Procedure\File Input Output\HDF5 Browser.ipf
Move the alias or shortcut into the “Igor Pro User Files\Igor Procedures” folder. This activates the procedure file that implements an HDF5 browser and adds a “New HDF5 Browser” menu item in the Data  Load Waves menu.
C. Restart Igor Pro and then read the HDF5 Guided Tour section below.

To uninstall the HDF5 package, delete the aliases or shortcuts created above and restart Igor. 
For background information on special folders such as the Igor Extensions and Igor Procedures folders, see Special Folders.
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